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NEW QUESTION 1
- (Exam Topic 1)
You need to add controls to the check-in solution for the health and wellness questions. Which form control should you use?

A. Drop down
B. Check box
C. Text input

Answer: A

NEW QUESTION 2
- (Exam Topic 1)
You need to embed the check-in solution into the communication solution. To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, application, Word Description automatically generated
Box 1: Power Apps Web Studio
Scenario: The check-in solution must continue to function if there are internet issues. If the self-service kiosks are not available, staff must be able to use the check-
in solution from within their communication solution.
PowerApps Studio is a browser application used to edit your apps. PowerApps Studio includes a
drag-and-drop canvas in the center of the screen and a screen or object list pane on the left. Properties, Rules, and Advanced Properties for selected screens or
controls are displayed in the right pane.
Box 2: in a tab
You can customize the Teams experience by adding Power Apps canvas apps to your channels in Teams using the PowerApps tab.

NEW QUESTION 3
- (Exam Topic 1)
You need to design and create the solution for gathering contact information from guests for marketing purposes.
What should you use? To answer, select the appropriate options In the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 4
- (Exam Topic 1)
You need to create the FAQ solution content What should you do first?

A. Al Builder
B. Suggest topics
C. Automate
D. Trigger phrases

Answer: B

Explanation: 
You need to make sure there are three main steps need to do while doing import FAQ and add the topic to your bot application.

 Import Suggested Topics from FAQ webpage.

 Add a topic.

 Enable the topics Reference:
https://social.technet.microsoft.com/wiki/contents/articles/53820.power-virtual-agents-faq-chatbot.aspx

NEW QUESTION 5
- (Exam Topic 1)
You need to design the resort portal's email registration process.
Which solutions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 6
- (Exam Topic 1)
You need to design the guest check-in solution.
Which technologies should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
You need to design the guest check-in solution.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Canvas app,
Power Apps mobile app
https://docs.microsoft.com/en-us/power-apps/maker/canvas-apps/offline-apps

NEW QUESTION 7
- (Exam Topic 2)
You need to resolve the issue reported by substitute employees after they are assigned service requests. How should you configure the system? To answer, select
the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Service Request 1:N Qualification
When users go on vacation, all their outstanding Service Request records are assigned to a substitute employee. The substitute employees are unable to see all
the qualifications related to their service requests.
Box 2: Cascade All
Cascade All - Perform the action on all referencing table records associated with the referenced table record. Reference:
https://docs.microsoft.com/en-us/power-apps/developer/data-platform/configure-entity-relationship-cascading-b

NEW QUESTION 8
- (Exam Topic 2)
You need to be able to move a Power Automate desktop flow used in the verification process to the testing environment.
What should you do?

A. Share a copy of the desktop flow with a member of internal IT.
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B. Use the Export option in the flow to get the flow identifier and provide it to internal IT.
C. Send a copy of the desktop flow to a member of internal IT.
D. Create the desktop flow in a solution and provide it to internal IT.

Answer: D

Explanation: 
Internal IT reports that the solution import to the test environment failed because of missing dependencies related to the flow for completing service requests.
Flows with PowerApps steps
Flows that were created via Power Automate in the PowerApps menu or flows that have PowerApps steps added have a different issue then other Power
Automate flows. As of the writing of this blog these flows are not able to be imported into another environment. This means that if you create flows with Power
Apps steps within them you will need to recreate them in your destination environment.
Reference: https://www.spyglassmtg.com/blog/power-platform-solution-export-and-import-issues

NEW QUESTION 9
- (Exam Topic 3)
You plan to create classic workflows for process automation on the Account table. The process automation has the following requirements:
• If the Account Name column changes, a custom column named Previous Name must be updated with the original value.
• If the Credit Limit column changes, an email must be sent to the record owner with the new value.
• Asynchronous processes must be used whenever possible. You need to implement the process automation.
What is the minimum number of workflows you should use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 10
- (Exam Topic 3)
You are designing a desktop user interface (Ul) flow. The Ul flow automates legacy software.
You need to prepare data for transfer to a Microsoft SharePoint list.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-automate/ui-flows/inputs-outputs-desktop#use-outputs-to-extract-inform

NEW QUESTION 10
- (Exam Topic 3)
You are a Dynamics Sales administrator for a car dealership. The dealership uses only out-of-the-box functionality. When a new car is sold, the salesperson uses
a Word template to generate a letter from the quote to thank the customer.
You need to determine if you can revise the template. Which Word template change can you make?

A. Add the Discount field conditionally.
B. Format the table to have alternating color rows.
C. Format the Created On field to a long date format.
D. Add the address of the customer.D18912E1457D5D1DDCBD40AB3BF70D5D

Answer: D

NEW QUESTION 15
- (Exam Topic 3)
You plan to create a dataflow to import data into Microsoft Dataverse by using Power Query. The dataflow has the following requirements:
• A table of aggregated data must be created in dataflow storage.
• A unique identifier must be created for the table.
You need to configure the dataflow.
Which solutions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection Is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 16
- (Exam Topic 3)
A company creates a Microsoft Power Apps app through the Power Apps designer portal for use in Microsoft Teams.
This app needs to be promoted to the user acceptance testing environment.
You need to complete the Microsoft recommended actions before you export the solution. Which two actions should you complete? Each correct answer presents
part of the solution. NOTE: Each correct selection is worth one point.

A. Write validation tests.
B. Set the Optimized embedding appearance field to true.
C. Publish all changes.
D. Run the solution checker.
E. Clone a solution.

Answer: DE

Explanation: 
The Power Apps solution checker performs a rich static analysis check on your solutions against a set of best practice rules to quickly identify problematic patterns.
After the check completes, you receive a detailed report that lists the issues identified, the components and code affected, and links to documentation that
describes how to resolve each issue.
The solution checker analyzes these solution components: Common Data Service plug-ins
Common Data Service custom workflow activities
Common Data Service web resources (HTML and JavaScript) Common Data Service configurations, such as SDK message steps
Reference: https://www.eimagine.com/ui/

NEW QUESTION 17
- (Exam Topic 3)
You create a Power Apps app for Microsoft Teams using Microsoft Dataverse for Teams. Users report that they are unable to view the app in Teams. You need to
ensure that users can access the app. What should you do?

A. Share the app with a security group by using the Maker portal.
B. Share the app with a security group in Teams.
C. Request that a tenant administrator pin the app to the app bar in Teams.
D. Publish the app by using the Maker portal.
E. Share the app with individual users by using the Maker portal.

Answer: C

Explanation: 
When you create a Power Apps app for Microsoft Teams using Microsoft Dataverse for Teams, the app needs to be added to the app bar in Teams before it can
be accessed by users. This can only be done by a tenant administrator. To ensure that users can access the app, you would need to request that the tenant
administrator pin the app to the app bar in Teams.
Sharing the app with a security group by using the Maker portal (A) or in Teams (B) would allow users in that group to access the app, but they would still need to
be able to find and open the app.
Here are some references from Microsoft that may be helpful in understanding how to make Power Apps app available in Teams:

 Microsoft docs: Add a Power Apps app to a Microsoft Teams channel

 Microsoft docs: Pin a Power Apps app to the app bar in Microsoft Teams

 Microsoft docs: Distribute Power Apps for Microsoft Teams

NEW QUESTION 18
- (Exam Topic 3)
You are modifying a model-driven app. You set up a customer table in Microsoft Power Platform to retrieve user data. You set up a form with the following columns
for users to enter their data. The form includes the following columns:

The form must do the following:
• The Country/region column must automatically populate with US when English is chosen as a language. If the user selects Other for this column, the column
must remain blank so that user can enter a value.
• The Passport expiration date column must appear only if the user selects Yes in the Passport ownership column.
You need to configure the app with the least amount of effort.
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What should you configure? To answer, drag the appropriate solution component to the correct requirements. Each solution component may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface Description automatically generated with low confidence

NEW QUESTION 20
- (Exam Topic 3)
A company uses a canvas app.
Supervisors must approve transactions when a user from the sales department enters a revenue amount that is over $1 million.
You need to configure an approval process without using code. What should you create?

A. Column Expression
B. Power Automate cloud flow
C. Azure Service Bus service
D. Power Apps component framework (PCF) control

Answer: B

NEW QUESTION 22
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

 0 - 17

 18 - 25

 26 - 35

 36 - 55

 55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Use Date and time for Identify in the question
and then add branches that use conditional logic to
determine the age group.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 23
- (Exam Topic 3)
A company is training an Al model using a custom table to determine the amount of time it takes to deliver a package based on several key fields.
The testing data used to train the model is used for all training and regression testing scenarios and is considered complete data.
The trained model predicts a 2 percent variance between the estimated delivery time and the actual delivery time of packages.
The executive sponsors reject the model because the actual variance is at 15 percent. You need to address the sponsors' concern
What should you do?

A. Reduce the size of the data used within the model.
B. increase the size of the data used with the model.
C. Use sample training data from Microsoft
D. Replace the training data with real-world data.

Answer: D

Explanation: 
Note: Start using AI Builder with sample data
Don't have any data of your own to create a model? No problem! We've got you covered.
Sample data is available for several AI Builder model types, together with instructions for working with the sample data.
Reference: https://docs.microsoft.com/en-us/ai-builder/samples

NEW QUESTION 25
- (Exam Topic 3)
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On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Relevance Search to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation: 
Relevance Search brings the following benefits:

 Finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming," or "streamed."

 Includes the ability to search documents found in Notes and Attachments on Emails and Appointments Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-releva

NEW QUESTION 28
- (Exam Topic 3)
You create a new independent software vendor (ISV) solution for a Power Apps app.
The Power Apps solution will be imported into multiple customer environments. The environments will have a large variety of solutions and publishers.
You need to avoid naming conflicts during solution import.
Which element should you configure?

A. Package type
B. Configuration page
C. Marketplace
D. Prefix
E. Version

Answer: D

Explanation: 
A solution publisher includes a prefix. The publisher prefix is a mechanism to help avoid naming collisions. This allows for solutions from different publishers to be
installed in an environment with few conflicts. For example, the Contoso solution displayed here includes a solution publisher prefix of contoso.
Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 30
- (Exam Topic 3)
A company uses a model driven app.
The company needs to automatically update the Status column in real time. You need to configure this feature.
Solution: Create a workflow that has a Change Status step. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 35
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

 0 - 17

 18 - 25

 26 - 35

 36 - 55

 55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Create a custom Age group entity and
synonyms for each individual age in the corresponding item.
Use Age group for Identify in the question.
Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 38
- (Exam Topic 3)
You attempt to deactivate several currencies in a Microsoft Dataverse environment. You are not able to deactivate one of the currencies.
You need to determine why you cannot deactivate the currency. What is the reason?

A. You are not the currency record owner.
B. The currency is used by an active business process.
C. The currency is the base currency.
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D. The currency is used by another record.

Answer: C

Explanation: 
Reference:
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/org-service/web-service-error-codes https://docs.microsoft.com/en-us/power-
platform/admin/manage-transactions-with-multiple-currencies

NEW QUESTION 40
- (Exam Topic 3)
A company has a portal. Users sign into the portal by using a social media account.
The company wants to replace the existing portal with a Power Apps portal. users must sign up for access to the portal by using a Microsoft account and a unique
invitation code that will be provided to the users.
You need to configure authentication for the home page.
Which values should you use? To answer, drag the appropriate values to the appropriate authentication settings. Each value may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
NO NO

NEW QUESTION 44
- (Exam Topic 3)
A bank uses Power BI visualizations to help determine whether they should loan money to a customer. The bank has three different visuals that are part of a
Power BI report. The bank uses a set of four risk variables that indicate whether the customer is creditworthy.
You must create a mechanism so that bank employees can change the values of the four risk variables. Changes to the value of any variable must cause the three
visualizations to update.
You need to create the solution.
Which action should you perform? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Embed a Power BI report in a model-driven app
You can embed a Power BI report in a model-driven app main form. Box 2: Use the Power BI service.
The Power BI cloud service works with Microsoft Dataverse apps to provide a self-service analytics solution. Power BI automatically refreshes the app's data
displayed. With Power BI Desktop or Microsoft Excel, Power Query for authoring reports and Power BI for sharing dashboards and refreshing data from model-
driven apps,
your users have a powerful way to work with your app's data.
Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/embed-powerbi-report-in-system-form
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/use-power-bi
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NEW QUESTION 49
- (Exam Topic 3)
A company uses a Power Apps app with Microsoft Dataverse.
The company requires the import of records into Dataverse. Duplicate records in the data must be deleted without user intervention.
You create a duplicate detection rule.
You need to configure the rule for the data import. Which option should you configure?

A. Enable the Templates for Data Import option.
B. Enable the When a record is created or updated option.
C. Disable the Allow Duplicates option.
D. Enable the During data import option.

Answer: D

Explanation: 
When configuring a duplicate detection rule in Power Apps with Microsoft Dataverse, to automatically delete duplicate records during a data import, you should
enable the "During data import" option. This option allows the detection rule to automatically delete duplicates as they are imported into the system, without
requiring user intervention.
References:

 https://docs.microsoft.com/en-us/power-platform/admin/create-duplicate-detection-rule

 https://docs.microsoft.com/en-us/power-platform/admin/data-integration-duplicate-detection 

NEW QUESTION 51
- (Exam Topic 3)
A company uses a canvas app to manage production resources in a specific region. Employees must be at company locations to use the app.
Due to a sudden requirement for employees to work remotely, employees no longer commute to a specific location to conduct their work and cannot access the
canvas app.
You must reconfigure the app to ensure that employees only access the app from a limited number of locations.
You need to restrict access to the app.
Which components should you configure? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/restrict-access-online-trusted-ip-rules

NEW QUESTION 53
- (Exam Topic 3)
You have a canvas app.
The canvas app must store data in a variable that is available only to the current screen. You need to create the variable.
Which two functions should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. Navigate
B. UpdateContext
C. Set
D. Collect
E. SaveData

Answer: BC

Explanation: 
* B. UpdateContext function can be used to create a variable that is only available to the current screen. This function takes in an object that defines the variable
and its initial value, and updates the context of the current screen with that variable. Reference:
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https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-updatecontext
* C. Set function can be used to assign a value to a variable. The Set function sets a variable to a specified value, which is useful when you need to update the
value of a variable. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-set

NEW QUESTION 56
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.
The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable OneDrive for Business.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 60
- (Exam Topic 3)
You are customizing a model-driven app for a company. You create a Theme template to ensure the company logo and colors are properly used within these
apps.
The theme must meet the following requirements:

 Updated to add the logo

 Downloaded by the makers to create the app
You need to configure the assets. To answer, drag the appropriate configurations to the correct requirements. Each configuration may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Upload the theme elements as new web resources.
Each type of icon is stored as a web resource. Create a web resource first and then set the icons to use them. Alternatively, you can add the icon by creating a
new web resource when you define the table properties.
Box 2: Replace an existing UI item's hexadecimal number. Copy and alter the existing theme
The easiest and quickest way to create a new theme is to clone and alter an existing theme. Then save, preview, and publish it.

 Sign in to Power Apps, select Settings icon (upper right), and then select Advanced settings.

 Select Customizations, and then select Themes.

 Under All themes, select the theme you want to clone, such as the CRM Default Theme. Select Clone on the command bar.

 Replace an existing UI item's hexadecimal number, such as the Title Text Color, with the hexadecimal value that represents the color you want.
For example, the CRM Default Theme was cloned and changed using mostly varying shades of green color. The following screenshots show the new colors for
navigation and highlighting. A custom logo was also added that will appear in the upper left corner of an app.
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Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-themes-organization-branding

NEW QUESTION 63
- (Exam Topic 3)
You are implementing a model-driven app to support a new line of business. There are several places where automated business logic must be applied. You need
to determine how to apply the business logic.
Which method should you use? To answer, drag the appropriate methods to the appropriate business logic statements. Each method may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Business rule
By combining conditions and actions, you can do any of the following with business rules:

 NSE5_FSM-5.2 Set column values

 Clear column values

 Set column requirement levels

 Show or hide columns

 Enable or disable columns

 Validate data and show error messages

 Create business recommendations based on business intelligence. Box 2: Real-time workflow
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Real-time workflows:
Graphical user interface, text, application, email Description automatically generated

Box 3: Power Automate instant flow
Instant Flows don’t have a trigger in the same way as the Automated flow. Instead, they are triggered manually or on-demand, such as a user clicking a Flow
button in the mobile app.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-business-rules-recommendations-a https://docs.microsoft.com/en-
us/powerapps/maker/data-platform/configure-workflow-steps https://carldesouza.com/difference-between-instant-automated-and-scheduled-flows-in-power-
automate-and-ho

NEW QUESTION 68
- (Exam Topic 3)
You are a Dynamics 365 for Customer Service administrator.
You must create a form for team members to use. The form must provide the ability to:

 Lock a field on a form.

 Trigger business logic based on a field value.

 Use existing business information to enhance data entry.
You need to implement business rule components to create the form.
Which components should you use? To answer, drag the appropriate components to the correct requirements. Each component may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

 Action

 Condition

 Recommendation

NEW QUESTION 70
- (Exam Topic 3)
You are creating a business process flow for a Power Apps app. The business process flow must meet the following requirements:
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• Must be available offline.
• Send an email to the team when a record is created. You need to set up business process flow.
What should you do? To answer, select the appropriate options in the answer area. Each correct selection is worth one point

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated

NEW QUESTION 72
- (Exam Topic 3)
A company is updating a Power Apps solution that contains two tables named Sen/ices and Equipment. The company is creating a new solution to update the
current solution for the following requirements:
• The Services table must be updated to include change tracking.
• The Equipment table must be updated to include four new columns.
• The solution must update only the components that need to be added or changed. You need to create the solution.
Which table option should you use? To answer, drag the appropriate options to the correct tables. Each option may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Select components Option for Services Table Select components Option for Equipment Table
The "Select components" table option allows you to update specific components of a table, such as adding new columns or change tracking, while keeping the
existing data and relationships in the table intact. This meets the requirement that the solution must update only the components that need to be added or
changed.
You can use the Power Apps maker portal and navigate to the Environment, then click on the Data tab, select the table you want to update and click on the
settings icon and then select "Select components" from the options. Then you can select only the columns you want to add or update for each table.
This way, you can ensure that the solution will update only the necessary components for each table, including change tracking for the Services table and four new
columns for the Equipment table, without affecting the existing data and relationships in the tables.

NEW QUESTION 77
- (Exam Topic 3)
A company creates a model-driven app.
Users require access to a Power Bl report that is embedded in the app. You need to configure the app.
Where should you add the report?

A. XML report
B. Dashboard
C. Business rule
D. Power Automate cloud flow

Answer: B

Explanation: 
To add a Power BI report to a model-driven app, you should add it to a dashboard. Dashboards in
model-driven apps provide a way to organize and display information, such as charts, tables, and reports. You can add a Power BI report to a dashboard by
creating a new dashboard and then adding a Power BI report component to it. This component allows you to specify the report you want to add and configure its
properties, such as size and layout. Users will then have access to the embedded report when they view the dashboard in the app. Reference:
https://docs.microsoft.com/en-us/power-platform/admin/create-model-driven-app-dashboards
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NEW QUESTION 78
- (Exam Topic 3)
A company plans to create two Microsoft Power Platform applications.
One of the applications requires a custom control layout without using code. The other application will be used primarily by external users.
You need to create the applications.
Which application types should you use? To answer, drag the appropriate application types to the correct requirements. Each application type may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 80
- (Exam Topic 3)
You make the following customizations to a Microsoft Dataverse Environment
• Create a new table
• Add data to the new table.
• Delete an unused area from the site map.
The components must be transported to a different environment.
You need to determine the method required to transport each component.
Which method should you use? To answer, drag the appropriate methods to the correct components. Each method may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 82
- (Exam Topic 3)
A company uses Power Apps with Microsoft Dataverse.
The company enables auditing on the Dataverse database. The company tenant reaches the maximum storage capacity.
You need to delete some auditing data.
Which three deletion options should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. by table
B. by record
C. between two specified dates
D. by column
E. older than a specified date

Answer: ACE

Explanation: 
* A. Deleting by table allows you to select specific tables in the Dataverse database for which you want to delete the auditing data. This can be done by going to
the Power Apps portal, navigating to the Data tab, and selecting the table for which you want to delete the auditing data. You can then select the specific auditing
data you want to delete and click the "Delete" button. This is useful if you want to only delete auditing data for specific tables and not for the entire database.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs
* C. Deleting between two specified dates allows you to select a range of dates within which the auditing data will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Between two dates"
option. Then you can specify the start and end date for which you want to delete the auditing data. This is useful if you want to delete auditing data for a specific
time period and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs
* E. Deleting older than a specified date allows you to select a specific date, and any data older than that date will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Older than a
specified date" option. Then you can specify the date for which you want to delete the auditing data. This is useful if you want to delete auditing data that is older
than a certain date and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-
audit-logs
It's always good to have a backup of Data before deletion and also check the retention period of the data you want to delete.

NEW QUESTION 84
- (Exam Topic 3)
You use Power BI Desktop to configure Power BI reports.
You need to create a canvas app that displays user account information and include the app in a Power BI
report.
Which three actions should you perform? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. From the Power Apps Insert menu, add a Power BI tile
B. From the Power BI Desktop menu, insert a Power Apps visual and include the required fields in the Power Apps data
C. Publish the report to the Power BI service
D. Connect to Common Data Service from Power BI Desktop

Answer: BCD

Explanation: 
Step 1 (B): Here’s how we embed PowerApps into a Power BI report:

 Download and login to the Power BI desktop application

 Click on (…) and select “Import from the marketplace.”
Step 2: Open Power BI desktop and use “Get data” to connect with the Common Data Service data source. Step 3: Publish the report to Power BI service.
Reference:
https://purple.telstra.com/blog/powerbi-integration-with-powerapps

NEW QUESTION 89
- (Exam Topic 3)
A company uses Microsoft Teams. You plan to create a Power Apps app for Microsoft Teams. You need to determine the environment that will used by the app.
Which environment will the app use?

A. An existing Dataverse environment that you select.
B. An existing Dataverse for Teams environment that you select.
C. A Dataverse environment that is automatically created for the team.
D. A Dataverse for Teams environment that is automatically created for the team.

Answer: D

Explanation: 
The Dataverse for Teams environment is automatically created for the selected team when you create an app or bot in Microsoft Teams for the first time or install a
Power Apps app from the app catalog for the first time. The Dataverse for Teams environment is used to store, manage, and share team-specific data, apps, and
flows. Each team can have one environment, and all data, apps, bots, and flows created with the Power Apps app inside a team are available from that team's
Dataverse for Teams database.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/about-teams-environment

NEW QUESTION 90
- (Exam Topic 3)
You implement an editable grid for the Account entity.
The business team provides the following list of features that they would like you to implement:
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 Group by or sort columns in the current view.

 Configure a business rule to show an error message.

 Edit values in calculated fields.

 Edit the Address composite field.

 Use the editable grid on mobile phones.
Which actions can you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 93
- (Exam Topic 3)
You ate a Dynamics 365 help desk administrator
You need to create a dashboard that displays information on help desk cases that ate handled each week. Which dashboard components should you use? To
answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
 System Personal Personal
Personal System
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/basics/add-edit-power-bi-visualizations-da

NEW QUESTION 96
- (Exam Topic 3)
A company uses a model-driven app with Microsoft Dataverse in a single environment
The company requires a canvas app that includes the same data as the model-driven app. You need to create the canvas app.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 99
- (Exam Topic 3)
A company uses Power Apps.
The company plans to create a canvas app that uses a responsive design. You need to configure the app.
Which two actions should you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Enable the lock orientation setting.
B. Configure the height and width properties by using a formula.
C. Disable the Scale to fit setting.
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D. Configure the height and width properties by using drag handles.

Answer: BC

Explanation: 
To create a canvas app that uses a responsive design in Power Apps, you should perform the following actions:
* B. Configure the height and width properties by using a formula: By using a formula to set the height and width properties, you can ensure that the app will
respond to changes in screen size and orientation. For example, you can use the Width() and Height() functions to set the width and height properties based on
the size of the screen.
* C. Disable the Scale to fit setting: The Scale to fit setting, when enabled, makes the app's content fit on the screen by scaling it down. To create a responsive
app, this setting must be disabled.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/responsive-design https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/functions/function-width

NEW QUESTION 102
- (Exam Topic 3)
You are designing a Power Virtual Agents chatbot.
You observe that the environment you plan to use does not appear as an option in the Power Virtual Agents user interface.
You need to ensure that you can create the chatbot in the environment that you want to use. What should you do?

A. Create an environment in a supported region.
B. Convert the environment to a sandbox environment.
C. Change the region for the environment.

Answer: A

Explanation: 
The environment doesn't show up in the drop-down menu of Power Virtual Agents
Your environment might not show up in the drop-down menu due to one of the following:
The environment doesn't have a database created. To resolve this issue, go to admin.powerplatform.com to create a database in your environment.
The environment is created in an unsupported region.
Reference: https://docs.microsoft.com/en-us/power-virtual-agents/environments-first-run-experience

NEW QUESTION 107
- (Exam Topic 3)
You create a Power Apps app.
The app must be able to display a list of records that are sorted by category. The app must also expand or hide the list by subtopics.
You need to configure the app. Which tool should you use?

A. card
B. expression
C. Power Bl dashboard
D. gallery

Answer: D

Explanation: 
A gallery control in Power Apps allows you to display a list of records, and can be configured to sort the records by a specific field, such as category. Additionally,
the gallery control has built-in functionality for expanding or hiding a list of subtopics. This can be done by adding a toggle control within the gallery template to
show or hide the subtopics based on user interaction. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-gallery

NEW QUESTION 112
- (Exam Topic 3)
You are a Dynamics 365 Customer Service system administrator. You create an app for the sales team. Members of the sales team cannot access the app.
You need to ensure that sales team members can access the app. Where should you configure app permissions?

A. Security Roles
B. Manage Roles
C. Dynamics administration center
D. Dynamics 365 home

Answer: B

Explanation: 
 References:
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/manage-access-apps-security-r Manage access to apps by using security roles.
You can choose what users see and access from the My Apps page or the Customer Engagement home page by giving app access to specific security roles.
Users will have access to apps based on the security roles they're assigned to.
* 1. Go to Settings > My Apps.
* 2. In the lower-right corner of the app tile you want to manage access for, select More options (...), and then select Manage Roles.
* 3. Enter the following in the Manage Roles dialog box:
a) App URL Suffix
b) Roles
c) Select Save.
* 4. Refresh the My Apps page.
* 5. Go to the Apps Being Edited view, and publish the app again. Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-app

Passing Certification Exams Made Easy visit - https://www.surepassexam.com



Recommend!! Get the Full PL-200 dumps in VCE and PDF From SurePassExam
https://www.surepassexam.com/PL-200-exam-dumps.html (211 New Questions)

NEW QUESTION 114
- (Exam Topic 3)
You need to create a Power Automate desktop flow.
What are two possible ways to create the flow? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Record mouse and keyboard events.
B. Configure a pre-built template.
C. Use pre-built actions.
D. Create models by using Microsoft Visio.

Answer: AC

Explanation: 
C: Desktop flows are used to automate tasks on the Web or the desktop. Using Power Automate you can automate tasks on the desktop as well as the Web.
A: Alternatively, you can use the two legacy methods of creating desktop flows: Windows recorder (V1) and Selenium ID. With these you record mouse and
keyboard events.
Reference:
https://docs.microsoft.com/en-us/power-automate/desktop-flows/create-flow https://docs.microsoft.com/en-us/power-automate/desktop-flows/create-web

NEW QUESTION 119
- (Exam Topic 3)
A company uses a model-driven Power Apps app in a new environment. The base language is English. You need to configure French and Spanish.
Which configuration component should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Language packs
Before users can start using a Language Pack to display a language, the Language Pack must be enabled in your organization.
Box 2: Environment Enable the language
These settings can be found in the Microsoft Power Platform admin center by going to Environments > [select an environment] > Settings > Product > Languages.
Reference: https://docs.microsoft.com/en-us/power-platform/admin/enable-languages

NEW QUESTION 122
- (Exam Topic 3)
You have a model-driven app. You create five Microsoft Excel templates for analyzing customer data. Four of the templates must be available to all users. The
remaining template must be available only to you.
You configure the appropriate security roles for users.
You need to determine how to upload the Excel templates.
Which method should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Table Description automatically generated with medium confidence
Box 1: In the Settings menu, select Document Templates
Templates uploaded from the Settings page are available to all users. You don't need to take any further action. Administrators can use the Settings page to
upload the Excel template. A template uploaded in Settings is
available to all users.
For admins: Upload the Excel template

 Go to Settings > Templates > Document Templates.

 Click Upload Template.

 Drag the Excel file into the dialog box or browse to find and upload the file.

 Upload Template dialog box.

 Click Upload.
Box 2: In the view for the email records, select Excel templates
Note: For non-admins or admins wanting to create a personal template: Upload the Excel template
Open a page with a list of records, for example, the list of Sales Opportunities. Go to Sales > Opportunities > My Open Opportunities.

 On the menu bar, click Excel Templates > Create Excel Template.

 Click Excel Template > Upload.

 Click Upload to add the Excel template.

 Drag the file into the dialog box or browse to find and upload the file.

 Click Upload.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/analyze-your-data-with-excel-templates

NEW QUESTION 124
- (Exam Topic 3)
You use Power Bl Desktop to configure Power Bl reports and dashboards.
You need to create a canvas app that displays account information and include the app in a Power Bl report. Which three actions should you perform? Each
correct answer presents part of the solution.
NOTE Each correct selection is worth one point.

A. Publish the report to the Power Bl service.
B. Connect to Common Data Service from Power Bl Desktop.
C. Connect Common Data Service from Power Bl Deskto
D. Selected required fields from the Accounts table.
E. From the Power Apps Insert menu, add a Power Bl
F. From the Power Bl Desktop menu, insert a Power Apps visual and include the required fields in the Power Apps data.

Answer: CDE

NEW QUESTION 127
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history.
Solution: From Dynamics 365 Settings, select Email Configuration. In the active mailbox for the user, update the name.
Does the solution meet the goal?

A. Yes
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B. No

Answer: B

Explanation: 
Change the user name, not the email configuration. Change a user's email address
You must be a global admin to complete these steps.

 In the admin center, go to the Users > Active users page.

 Select the user's name, and then on the Account tab select Manage username.

 In the first box, type the first part of the new email address. If you added your own domain to Microsoft 365, choose the domain for the new email alias by using
the drop-down list. Learn how to add a domain.

 Select Save changes. Reference:
https://docs.microsoft.com/en-us/microsoft-365/admin/add-users/change-a-user-name-and-email-address

NEW QUESTION 131
- (Exam Topic 3)
You are creating a canvas app.
A user will click a button on each screen of a Power Apps app to proceed to the next screen. You need to implement an action that selects the next screen that the
user sees.
Which event should you handle?

A. OnLoad
B. OnCheck
C. ScreenTransition
D. OnSelect

Answer: D

Explanation: 
 Add navigation
* 1. With the Source screen selected, open the Insert tab, select Icons, and then select Next arrow.
* 2. With the arrow still selected, select the Action tab, and then select Navigate.
* 3. The OnSelect property for the arrow is automatically set to a Navigate function.

* 4. When a user selects the arrow, the Target screen fades in.
* 5. On the Target screen, add a Back arrow, and set its OnSelect property to this formula:
* 6. Navigate(Source, ScreenTransition.Fade)
* 7. While holding down the Alt key, toggle between screens by selecting the arrow on each screen. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables

NEW QUESTION 134
- (Exam Topic 3)
You create a Power Virtual Agents chatbot to reduce the number of incoming support calls that require a live person.
The chatbot does not direct users to the correct information. You determine that this is because the chatbot is not able to identify which product a user is referring
to in a conversation.
You need to present a list of products so that users can select the correct product. What should you create?

A. Table
B. Variable
C. Slot filling
D. Entity

Answer: C

Explanation: 
Slot filling is a natural language understanding concept that means saving an extracted entity to an object. However, in Power Virtual Agents, slot filling means
placing the extracted entity value into a variable.
Reference: https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 137
- (Exam Topic 3)
You create a Power Virtual Agents bot.
You observe that the bot is not able to recognize input from some users. You need to configure the bot response for unrecognized input from users.
What are two possible ways to achieve this goal? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. Transfer to an agent.
B. Use a fallback topic.
C. Display a system-defined error message.
D. Connect to a different channel.

Answer: BC

Explanation: 
* B. Use a fallback topic: Power Virtual Agents provides the capability to handle unrecognized inputs by using fallback topics. A fallback topic is a topic that is
triggered when the bot is unable to recognize the user input. You can configure fallback topics by going to the Power Virtual Agents portal, and then select the bot
you want to configure. Then select the "Topics" tab and create a new topic with a fallback trigger. Reference: https://docs.microsoft.com/en-us/power-virtual-
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agents/topics-triggers#fallback-triggers
* C. Display a system-defined error message: This is another option to handle unrecognized inputs by displaying a predefined message that inform the user that
the bot was unable to understand their input.

NEW QUESTION 142
- (Exam Topic 3)
You have a classic workflow. The workflow updates a custom column on a record when an account record is created. The workflow must update the custom
column based on the following conditions:
• Update the custom column value using the Account Number.
• If the Account Number column is blank, update the custom column value using the Ticker Symbol.
• If the Ticker Symbol column is blank, update the custom column value to N/A
You need to configure the custom column value by using the update record step. What should you do?

A. Add the two columns with the default value by using the Forms Assistant.
B. Add an expression that evaluates the two column values and uses the first populated value or else the default value.
C. Add check conditions to determine if the two columns contain data.
D. Add a formula that evaluates the two column values and uses the first populated value or else the default value

Answer: A

NEW QUESTION 143
- (Exam Topic 3)
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Quick Find search on the Notes list to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead use Relevance Search.
Note: Relevance Search finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming,"
or "streamed."
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-releva

NEW QUESTION 145
- (Exam Topic 3)
You need to embed the FAQbot into the communication solution.
Which actions should you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 150
- (Exam Topic 3)
A company uses a model-driven app. The app uses a Power Virtual Agents chatbot.
The company has two locations in different countries/regions with separate environments for each location. Each location has a development environment, a
testing environment, and a production environment. The company uses the Application Lifecycle Management (ALM) process for the environments.
You need to create the different Power Virtual Agents bot environments. How many Power Virtual Agents bot environments are required?

A. 1
B. 2
C. 3
D. 6

Answer: D

Explanation: 
When a company uses a model-driven app that incorporates a Power Virtual Agents chatbot, and has multiple locations with different environments for each
location, it is necessary to create separate Power Virtual Agents bot environments for each location.
For each location, 3 different environments are required: development, testing, and production. This is in line with the Application Lifecycle Management (ALM)
process that the company uses.
In total, 6 Power Virtual Agents bot environments are required: 2 locations x 3 environments per location = 6. It's worth mentioning that Power Virtual Agents allows
to export and import the bot, so once you configure the bot in one environment, you can import the bot to the other environments, this way you don't need to start
from scratch.
References:

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-lifecycle

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/export-import

NEW QUESTION 154
- (Exam Topic 3)
You have a form that displays a custom field from an entity.
A customer wants to restrict users from filtering on the custom field. You need to prevent users from filtering the field in Advanced Find. What should you modify?

A. Fields in the Edit Filter Criteria option of the Quick Find view
B. the Field Security field on the Field Properties form
C. a searchable field on the Field Properties form
D. Fields in the Add Find Columns option of the Quick Find view

Answer: C

Explanation: 
Reference:
https://community.dynamics.com/365/b/dynamics365apps/posts/kb-understanding-dynamics-365-field-ssearcha

NEW QUESTION 156
- (Exam Topic 3)
You need to create a system chart for the Account entity.
The chart must display a count of accounts grouped by owner and then display the accounts by Address 1: State/Province for each owner. You begin to configure
chart options as shown in the image below.
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How should you complete the configuration? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point. The chart must display a count of accounts grouped by owner, and then display the accounts by Address 1 to
State/Province for each owner.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 159
- (Exam Topic 3)
You need to recommend a role for users to perform several required tasks. The solution must use the principle of least privilege.
Which roles should you recommend? To answer, drag the appropriate roles to the correct functions. Each role may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Office 365 Global Administrator
You may think that the Dynamics 365 system administrator would have power to do all the actions needed to manage Dynamics 365, but this is not the case.
What's different in Microsoft cloud deployments is that licenses and user accounts are managed in Office 365 by an Office 365 Global Administrator. This role is
analogous to a network administrator for an on premises deployment. The Global Administrator is the only role to create new user accounts and assign
subscription licenses for Dynamics 365 (and other Office 365 apps such as Skype, Power BI and SharePoint).
Box 2: Dynamics 365 system administrator
The Dynamics 365 system administrator may assign roles and permissions to the Dynamics 365 user within an instance of Dynamics 365. The Dynamics 365
system administrator also controls all the settings in Dynamics 365.
Box 3: Dynamics 365 admin
The Dynamics 365 admin can perform backups and restores. Reference:
https://docs.microsoft.com/en-us/power-platform/admin/use-service-admin-role-manage-tenant
https://community.dynamics.com/crm/b/govandthecity/posts/understanding-dynamics-365-and-office-365-admi

NEW QUESTION 163
- (Exam Topic 3)
A company has a sales application that is supported by an Azure SQL database. You are developing a Power Apps app for use by customer service agents.
The app must reference customer data from the sales application. Data in the sales application is constantly changing and must not be replicated in Microsoft
Dataverse
Some customer data is considered sensitive. You must protect data for specific fields when users view data in the app.
You need to configure table creation for the app.
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How should you configure the app? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 167
- (Exam Topic 3)
You are designing an app for a bank.
You must create entities for the app and configure relationships between entities:

Which relationship types should you use? To answer, drag the appropriate relationship types to the correct requirements. Each relationship type may be used
once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A
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Explanation: 
Text Description automatically generated
Box 1: N:1
You add a lookup column with a many-to-one relationship. Box 2: N:N
Box 3: N:1
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-entity-lookup

NEW QUESTION 172
- (Exam Topic 3)
A farm uses a canvas app to manage schedules for planting fields with crop seeds. The farm uses business intelligence to provide recommendations for schedule
changes based on weather data.
You must implement a business rule that changes information for several forms in the canvas app based on business intelligence data.
You need to configure the business rule. Which scope should you use?

A. Table
B. All Forms
C. Form specific

Answer: A

NEW QUESTION 175
- (Exam Topic 3)
You must create a new entity to support a new feature for an app. Entity data will be transactional and will be associated with business units.
You need to configure entity ownership. Which entity ownership type should you use?

A. user or team owned
B. organization-owned
C. none
D. business-owned

Answer: A

NEW QUESTION 176
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Datavserse Search to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 177
- (Exam Topic 3)
A company uses Power Apps and Power Automate.
There is an issue with the existing flow in the test environment. Development changes are allowed in the test environment.
You need to troubleshoot the issue with the flow.
Which command should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A
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Explanation: 
Graphical user interface, text, application Description automatically generated

NEW QUESTION 181
- (Exam Topic 3)
You are a Dynamics 365 administrator for a veterinarian clinic.
On the client appointment form, there is a dropdown field for clients to select their type of pet If a client selects the option Other, the veterinarian wants a text field
to appear so that additional details can be added.
You need to create a dynamically visible field. What should you configure?

A. filed visibility on the form
B. business process flow
C. workflow
D. business rule

Answer: D

Explanation: 
 References:
https://www.sherweb.com/blog/dynamics-365/configuring-business-rules-within-microsoft-dynamics-365-crm/ 

NEW QUESTION 184
- (Exam Topic 3)
A company is developing several Power Virtual Agents chatbots. The company manufactures more than 1,000 different products.
The chatbots must prompt users to enter or select a product.
You need to store the model information so that it can be reused across all chatbots. Where should you store the model data?

A. Global variables
B. Custom entities
C. Topics
D. Multiple choice options

Answer: A

NEW QUESTION 187
- (Exam Topic 3)
You are creating Power BI reports for a company.
A company that has a model-driven app wants to use Power BI reports within the app. You create the reports. You need to ensure that these reports are available
within the app.
Which two actions should you perform? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Share the Power Bl report to all users.
B. Add the Power Bl report to the Site Map dashboards.
C. Create a PCF file.
D. Use the native reports in model-driven apps.
E. Add the Power Bl report to a dashboard in the model-driven app.

Answer: BE

Explanation: 
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/add-powerbi-visual 

NEW QUESTION 190
- (Exam Topic 3)
A company uses Common Data Service to manage prospects. The company has a business process flow named BPFA that is associated with the Prospect entity
to streamline the prospect management process.
You add a field named Category to the Prospect entity. You create additional business process flows. You apply the business process flows to Prospect records
based on the selected category. Users can switch to any other newly configured business process flows but must not use BPFA.
You need to configure the solution.
What are two possible ways to achieve this goal? Each correct answer presents a complete solution. NOTE Each correct selection is worth one point.

A. Remove all of the privileges for BPFA.
B. Deactivate BPFA.
C. Use a business rule to prevent users from switching to BPFA.
D. Change the display order of the business process flows to move BPFA to the bottom of the list.

Answer: AB

NEW QUESTION 191
- (Exam Topic 3)
You have a canvas app that allows users to view, select and purchase products. The app uses a Gallery control to display products and checkboxes that allow
users to select products.
When users select items from the product catalog, they move to a different screen to complete a purchase. Users must be able to clear all product selections when
they click the button.
You need to configure the button. What should you do?

A. Use the Reset (Control) formula and pass the gallery control as a parameter to the Reset formula.
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B. Use the Reload(control) formula and pass the gallery control as parameter to the Reload formula.
C. Use the ForAall( ) function to iterate through each item of the Gallery and clear user selections.
D. Set the OnCheck value to populate a collection and the OnUncheck value to remove the item from the collectio
E. Clear the collection when the user selects the button.

Answer: D

Explanation: 
https://debajmecrm.com/quick-tip-resetting-controls-inside-gallery-in-canvas-app/

NEW QUESTION 192
- (Exam Topic 3)
A company has a model-driven app that uses Microsoft Dataverse.
Users need to add an alternate phone number when entering their account information. The users also require a list that displays the customers that do not have
an alternate phone number.
You need to enable the required features.
Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at
all. You may need to drag the split bar between panes or
scroll to view content.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 194
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

 0 - 17

 18 - 25

 26 - 35

 36 - 55

 55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Use multiple choice for Identify in the question
and create options that represent of the age groups. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 199
- (Exam Topic 3)
You manage the Dynamics 365 environment for a company.
You need to ensure that there are no leads for a customer before you create a new opportunity for the customer.
How can you use duplicate detection rules to achieve this goal? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 201
- (Exam Topic 3)
You create a canvas app.
The app requires access to data that is stored in collections. The app must provide the following actions:
• Create a new collection variable.
• Remove table values from a collection. You need to configure functions for the app.
Which functions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 205
- (Exam Topic 3)
You have a canvas app with an embedded Power Bl tile.
You share the canvas app. Users report that they are unable to access the Power Bl content. You need to determine why users are unable to access the content
What is the cause of the user s problems?

A. The Power Bl dashboard is not shared.
B. The Power Bl interactions property on the Power Bl tiles is set to Off.
C. The Power Bl connection is not shared.
D. The Power Bl Display mode property on the Power Bl tiles is set to Disabled

Answer: A

Explanation: 
When embedding a Power BI tile in a Canvas app, there are several factors that must be considered in order to ensure that users have access to the content. One
of the most important is sharing the Power BI dashboard that the tile is embedded in. If the dashboard is not shared with the users, they will not be able to view the
content in the tile.
To share a Power BI dashboard, you must have the "Edit" permission for the dashboard. Once you have this permission, you can share the dashboard with other
users by following these steps:

Click the "Share" button in the top-right corner of the dashboard.

 In the "Share" pane that appears, enter the email addresses of the users that you want to share the dashboard with.

 Select the level of access that you want to grant to the users. You can choose to give them "View" access, which allows them to view the dashboard but not
make changes, or "Edit" access, which allows them to view and make changes to the dashboard.

 Click the "Share" button to share the dashboard with the users. Additionally, there are other factors that could cause user's problems:

 B. The Power Bl interactions property on the Power Bl tiles is set to Off. In that case, the user's won't be able to interact with the visuals.

 C. The Power Bl connection is not shared. In that case, the user's won't have the access to the data source

 D. The Power Bl Display mode property on the Power Bl tiles is set to Disabled, in that case the user's won't see the tile
It is important to check all of these factors and ensure that they are properly configured in order to ensure that users have access to the content.
References:

 https://docs.microsoft.com/en-us/power-bi/service-admin-share-dashboard

 https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/embed-power-bi

 https://docs.microsoft.com/en-us/power-bi/service-embed-content/embed-in-powerapps

NEW QUESTION 206
......
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